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Chapter 723

Group-Sequential Analysis for One Hazard
Rate

Note: The corresponding sample size procedure, found in PASS Sample Size software, is Group-Sequential
Tests for One Hazard Rate (Simulation).

Introduction

This procedure is used to test the difference of a hazard rate compared to a null hypothesized value, in
stages (sometimes called looks or interim analyses), using group-sequential methods. This methodology
assumes an underlying Exponential model. Unless the stage boundaries are entered directly, the stage
boundaries are defined using a specified spending function. One- or two-sided tests may be performed with
the option of binding or non-binding futility boundaries. Futility boundaries are specified through a beta-
spending function.

Sample size re-estimation, based on current-stage sample sizes and parameter estimates, may also be
obtained in this procedure.

The spending functions available in this procedure are the O'Brien-Fleming analog, the Pocock analog, the
Hwang-Shih-DeCani gamma family, and the power family.

At each stage, the current and future boundaries are calculated based on the accumulated information
proportion. Conditional and predictive power for future stages is also given.

A group-sequential boundary and analysis graph is produced in this procedure.
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At each stage, stage-adjusted difference estimates, confidence intervals, and p-values are available.
The probabilities of crossing future boundaries may also be assessed, using simulation.

The format of the data for use in this procedure is shown in the Data Structure section below.

Outline of a Group-Sequential Study

There are three basic phases of a group-sequential (interim analysis) study:
e Design
e Group-Sequential Analysis

e Reporting

Design Phase - Determine the Number of Subjects

To begin the group-sequential testing process, an initial calculation should be made to determine the
sample size and target information if the final stage is reached (maximum information). The sample size
calculation requires the specification of the following:

e Alpha

e Power

e Test Direction (two-sided or one-sided direction)

e Types of boundaries (efficacy, binding futility, non-binding futility)

e Maximum number of stages

e Proportion of maximum information at each stage

e Spending functions

e Assumed survival rate

¢ Null survival rate
The design phase calculation may be done in the PASS sample size software program. PASS software
permits the user to easily try a range of hazard rates, as these values are typically not known in advance.

The resulting sample size of the sample size calculation also permits the calculation of the maximum
information, which is the total information of the study if the final stage is reached (for calculation details,
see the Information section later in this chapter).

Based on the maximum information, the target information and target sample size of each stage may be
calculated. In particular, this permits the user to have a target sample size for the first stage.

Although it is likely to change over the course of the group-sequential analysis, a design group-sequential
boundary plot can be a useful visual representation of the design:
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Group-Sequential Plot
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Group-Sequential Analysis Phase

A group sequential analysis consists of a series of stages where a decision to stop or continue is made at
each stage.

First Interim Stage

The design phase gives the target number of subjects for the first stage, based on the time of the first stage
and the accrual specification. The study begins, and response data is collected for subjects, moving toward
the first-stage target number of subjects, until a decision to perform an analysis on the existing data is
made. The analysis at this point is called the first stage.

Unless the number of subjects at the first stage matches the design target for the first stage, the calculated
information at the first stage will not exactly match the design information for the first stage. Generally, the
calculated information will not differ too greatly from the design information, but regardless, spending
function group-sequential analysis is well-suited to make appropriate adjustments for any differences.

The first stage information is divided by the maximum information to obtain the stage one information
proportion (or information fraction). This information proportion is used in conjunction with the spending
function(s) to determine the alpha and/or beta spent at that stage. In turn, stage one boundaries,
corresponding to the information proportion, are calculated.

A z-statistic is calculated from the raw hazard rate difference from the null value. The stage one z-statistic is
compared to each of the stage one boundaries. Typically, if one of the boundaries is crossed, the study is
stopped (non-binding futility boundaries may be an exception).
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Group-Sequential Plot
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If none of the boundaries are crossed the study continues to the next stage.
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If none of the boundaries are crossed it may also be useful to examine the conditional power or stopping
probabilities of future stages. Conditional power and stopping probabilities are based on the user-specified

supposed true difference.
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Second and other interim stages (if reached)

If the first stage time proportion is not equal to the design time proportion, a designation must be made at
this point as to the target time of the second stage. Two options are available in this procedure.

One option is to target the information proportion of the original design. For example, if the original design
proportions of a four-stage design are 0.25, 0.50, 0.75, 1.0, and the stage one observed proportion is 0.22,
the researcher might still opt to target 0.50 for the second stage, even though that now requires an
additional information accumulation of 0.28 (proportion). The third and fourth stage targets would also
remain 0.75 and 1.0.

A second option is to adjust the target information proportionally to the remaining proportions. For this
option, if the design proportions are 0.25, 0.50, 0.75, 1.0, and 0.22 is observed, the remaining 0.78 is
distributed proportionally to the remaining stages. In this example, the remaining target proportions
become 0.48, 0.74, 1.0.

For either option, once the target information is determined for the next stage, revised target sample sizes
are given, and the study continues until the decision is made to perform the next interim analysis on the
cumulative response data. In the same manner as the first stage, the current stage information proportion
is used with the spending function to determine alpha and/or beta spent at the current stage. The current
stage boundaries are then computed. The z-statistic is calculated and compared to the boundaries, and a
decision is made to stop or continue.

If a boundary is crossed, the study is typically stopped.
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If none of the boundaries are crossed the study continues to the next stage.
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Once again, if no boundary is crossed, conditional power and stopping probabilities may be considered
based on a choice of a supposed true difference.

The study continues from stage to stage until the study is stopped for the crossing of a boundary, or until
the final stage is reached.

Final Stage (if reached)

The final stage (if reached) is similar to all the interim stages, with a couple of exceptions. For all interim
analyses the decision is made whether to stop for the crossing of a boundary, or to continue to the next
stage. At the final stage, only the decision of efficacy or futility can be made.

Another intricacy of the final stage that does not apply to the interim stages is the calculation of the
maximum information. At the final stage, the current information must become the maximum information,
since the spending functions require that the proportion of information at the final look must be 1.0. If the
current information at the final stage is less than the design maximum information, the scenario is
sometimes described as under-running. Similarly, if the current information at the final stage is greater than
the design maximum information, the result may be termed over-running.

For both under-running and over-running, the mechanism for adjustment is the same, and is described in
the Technical Details section, under Information and Total Information.

Aside from these two exceptions, the final stage analysis is made in the same way that interim analyses
were made. The remaining alpha and beta to be spent are used to calculate the final stage boundaries. If
the test is a one-sided test, then the final stage boundary is a single value. The final stage z-statistic is
computed from the sample hazard rate of the complete data. The z-statistic is compared to the boundary
and a decision of efficacy or futility is made.
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Reporting Phase

Once a group-sequential boundary is crossed and the decision is made to stop, there remains the need to
properly summarize and communicate the study results. Some or all of the following may be reported:

e Boundary plot showing the crossed boundary

e Adjusted confidence interval and estimate of the hazard rate difference (from the null hypothesis
value)

e Sample size used

Boundary plot showing the crossed boundary

The boundary plot gives an appropriate visual summary of the process leading to the reported decision of
the study.
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Adjusted confidence interval and estimate of the hazard rate difference

Due to the bias that is introduced in the group-sequential analysis process, the raw data confidence interval
of the difference in hazard rate should not be used. An adjusted confidence interval should be used instead.
See the Adjusted Confidence Interval topic of the Technical Details section for details. The mid-point of the
adjusted confidence interval may be useful as a point estimate of the difference in hazard rate from the null
value. Further, the confidence level at which the adjusted confidence interval limit is zero gives a rough
adjusted p-value.
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Sample size used

The sample size at the point the study was stopped should be reported in addition to the sample size that
would have been used had the final stage been reached.

Technical Details

Many articles and texts have been written about group sequential analysis. Details of many of the relevant
topics are discussed below, but this is not intended to be a comprehensive review of group-sequential
methods. One of the more influential works in the area of group-sequential analysis is Jennison and
Turnbull (2000).

Null and Alternative Hypotheses

Many articles and texts have been written about group sequential analysis. Details of many of the relevant
topics are discussed below, but this is not intended to be a comprehensive review of group-sequential
methods. One of the more influential works in the area of group-sequential analysis is Jennison and
Turnbull (2000).

Null and Alternative Hypotheses

For comparing a hazard rate to a null value, the basic null hypothesis is that of equality,
Hy:h(T) = ho(T)
with three common alternative hypotheses,
Hy:h(T) # ho(T),
Hy:h(T) < ho(T) , or
Hq:h(T) > ho(T),

one of which is chosen according to the nature of the experiment or study.

These hypotheses may be specified equivalently as
Hy:h(T) —ho(T) =0
versus
Hy:h(T) — ho(T) # 0
Hy:h(T) — ho(T) < 0
Hy:h(T) — ho(T) > 0

A slightly different set of null and alternative hypotheses are used if the goal of the test is to determine
whether h(T) is greater than or less than hy(T) by a given amount.
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The null hypothesis then takes on the form

Hy:h(T) — ho(T) = Hypothesized Difference
and the alternative hypotheses,

Hg:h(T) — ho(T) # Hypothesized Difference

H,: h(T) — hy(T) < Hypothesized Difference

H,: h(T) — hy(T) > Hypothesized Difference

For testing these hypotheses with a hypothesized difference, the non-inferiority or superiority by a margin
procedure should be used instead.

Stages in Group-Sequential Testing

The potential to obtain the benefit from a group-sequential design and analysis occurs when the response
data are collected over a period of weeks, months, or years rather than all at once. A typical example is the
case where patients are enrolled in a study as they become available, as in many types of clinical trials.

A group-sequential testing stage is a point in the accumulation of the data where an interim analysis occurs,
either by design or by necessity. At each stage, a test statistic is computed with all the accumulated data,
and it is determined whether a boundary (efficacy or futility) is crossed. When an efficacy (or futility)
boundary is crossed, the study is usually concluded, and inference is made. If the final stage is reached, the
group-sequential design forces a decision of efficacy or futility at this stage.

For the discussions below, a non-specific interim analysis stage is referenced as k, and the final stage is K.

Test Statistic (MLE)

The z-statistic from MLE estimates for any stage k is obtained from all the accumulated data up to and
including that stage.

The general form of the test statistic is

hy — hy
Zy =
67 (hi)
with
n
~ Zj§1 Cik
hk = Nk
Zj:lx]k
anf Cik h?
~2(1 j=1%] k
Ok (hk) Nk
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where
hy, is the estimated hazard rate at stage k
672 (hy,) is the variance of the hazard rate estimator
Cji is an indicator of censoring

Xji is the elapsed time

Group-Sequential Design Phase

In most group-sequential studies there is a design or planning phase prior to beginning response collection.
In this phase, researchers specify the anticipated number and spacing of stages, the types of boundaries
that will be used, the desired alpha and power levels, the spending functions, and the anticipated hazard
rates with the corresponding estimate of the difference in hazard rates from the null value.

Based on these input parameters, an initial set of boundaries is produced, an estimate of the total number
of needed subjects is determined, and the anticipated total information at the final stage is calculated. The
appropriate procedure in PASS (sample size software) can be used to make these planning phase sample
size estimation calculations.

Information and Total Information

In the group-sequential design phase, the final stage (K) or total (design) information is calculated from the
specified rates and the final sample sizes, as

1
= o lp)
L%
where
02(hg, 1, p) is the variance of the hazard rate estimator
hy is the null hypothesized hazard rate
lis the loss hazard rate

p is the patient entry parameter

and
-1

o2 (ho, L, p) = h3 ho_, hope”MoV7(1 — eMoTTPT)
KA ® O\ho+1 (1—ePN0)(hg+D(hy+1—p)
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where
T, is the accrual time
T is the total time

If patient entry is uniform, the variance is (Lachin and Foulkes, 1986):

ho [ e~ (T-To)(ho+1) _ e—T(h0+l)]>‘1

2(ho, 1 p) = h2
9k (ho, L) °<h0+l ToChg + 1)

The information at any stage k, before any data is collected, may be calculated from the specified rates and
the sample size, as

1
Iy =————
¥ 62(hy, L, p)
Ny

The information at any data stage k for collected data may be calculated as

1

Iy = ———
62 (k)

with variance estimates as defined in the Test Statistic (MLE) section.
The proportion of the total information (or information fraction) at any stage is

pk_];%

The information fractions are used in conjunction with the spending function(s) to define the alpha and/or
beta to be spent at each stage.

To properly use the spending function at the final stage, it is required that px = 1. However, if the final stage
is reached, we see that

1
Iy=———#+f=—————
7 ok lp) T a(ho,Lp)
nKachieved nK
so that
I
pr =7 1
I

When I > I, itis called over-running. When Iy < I, it is called under-running. In either case, the spending
function is adjusted to accommodate the inequality, by redefining

Ig = Ig

See the discussion in Wassmer and Brannath (2016), pages 78-79, or Jennison and Turnbull (2000), pages
153-154, 162.
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Types of Boundaries

A variety of boundary designs are available to reflect the needs of the study design.

Efficacy Only (One-Sided)
The simplest group-sequential test involves a single set of stage boundaries with early stopping for efficacy.
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Efficacy Only (Two-Sided, Symmetric)

This boundary type would be used if the goal is to compare treatments, and it is not known in advance
which treatment should be better.
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Efficacy 1 and Efficacy 2 / Harm (Two-Sided, Asymmetric)

These boundaries might be used to show efficacy on one side or harm on the other side. This design might
be used in place of a one-sided efficacy and futility design if showing harm has additional benefit over
stopping early for futility.
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Efficacy and Binding Futility (One-Sided)

This design allows early stopping for either efficacy or futility. For binding futility designs, the Type | error
protection (alpha) is only maintained if the study is strictly required to stop if either boundary is crossed.
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Efficacy and Non-Binding Futility (One-Sided)

This design also allows early stopping for either efficacy or futility. For non-binding futility designs, the Type |
error protection (alpha) is maintained, regardless of whether the study continues after crossing a futility
boundary. However, the effect is to make the test conservative (alpha is lower than the stated alpha and

power is lower than the stated power).
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Efficacy and Binding Futility (Two-Sided, Symmetric)

This design allows early stopping for either efficacy or futility on either side. Alpha is preserved only if
crossing of futility boundaries strictly leads to early stopping for futility. In early looks of this design, the
futility boundaries may overlap. Overlapping futility boundaries may be skipped or left as they are.
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Efficacy and Non-Binding Futility (Two-Sided, Symmetric)

This design allows early stopping for either efficacy or futility on either side. Alpha is preserved even when
the study is allowed to continue after crossing a futility boundary. In early looks of this design, the futility
boundaries may overlap. Overlapping futility boundaries may be skipped or left as they are.
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Efficacy 1, Efficacy 2 / Harm, and Binding Futility (Two-Sided, Asymmetric)

This design allows early stopping for efficacy and efficacy futility, and for harm and harm futility (or efficacy
2 and efficacy 2 futility). Binding futility boundaries require that the study is stopped when a binding futility
boundary is crossed. In early looks of this design, the futility boundaries may overlap. Overlapping futility
boundaries may be skipped or left as they are.
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Efficacy 1, Efficacy 2 / Harm, and Non-Binding Futility (Two-Sided, Asymmetric)

This design allows early stopping for efficacy and efficacy futility, and for harm and harm futility (or efficacy
2 and efficacy 2 futility). Non-binding futility boundaries do not require that the study is stopped when a
binding futility boundary is crossed, but the study design is conservative. In early looks of this design, the
futility boundaries may overlap. Overlapping futility boundaries may be skipped or left as they are.
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Futility Only (One-Sided)

In this design, the interim analyses are used only for futility. Please be aware that, due to computational
complexity, these boundaries may take several minutes to compute, particularly when some stages are
skipped.
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Futility Only (Two-Sided, Symmetric)

In this design, the study is stopped early only for futility. Overlapping futility boundaries may be skipped or
left as they are. Please be aware that, due to computational complexity, these boundaries may take several
minutes to compute, particularly when overlapping boundaries are removed or some stages are skipped.
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Futility Only (Two-Sided, Asymmetric)

In this design, all stages previous to the final stage are used only for futility. Overlapping futility boundaries
may be skipped or left as they are. Please be aware that, due to computational complexity, these
boundaries may take several minutes to compute, particularly when overlapping boundaries are removed

or some stages are skipped.
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Boundary Calculations

The foundation of the spending function approach used in this procedure is given in Lan & DeMets (1983).
This procedure implements the methods given in Reboussin, DeMets, Kim, & Lan (1992) to calculate the
boundaries and stopping probabilities of the various group sequential designs. Some adjustments are made
to these methods to facilitate the calculation of futility boundaries.

Binding vs. Non-Binding Futility Boundaries

Futility boundaries are used to facilitate the early stopping of studies when early evidence leans to lack of
efficacy. When binding futility boundaries are to be used, the calculation of the futility and efficacy
boundaries assumes that the study will be strictly stopped at any stage where a futility or efficacy boundary
is crossed. If strict adherence is not maintained, then the Type | and Type Il error probabilities associated
with the boundaries are no longer valid. One (perhaps undesirable) effect of using binding futility
boundaries is that the resulting final stage boundary may be lower than the boundary given in the
corresponding fixed-sample design.

When non-binding futility boundaries are calculated, the efficacy boundaries are first calculated ignoring
futility boundaries completely. This is done so that alpha may be maintained whether or not a study
continues after crossing a futility boundary. One (perhaps undesirable) effect of using non-binding futility
boundaries is that the overall group-sequential test becomes conservative (alpha is lower than the stated
alpha and power is lower than the stated power).

Spending Functions

Spending functions are used to distribute portions of alpha (or beta) to the stages according to the
proportion of accumulated information at each look.

Spending Function Characteristics
e Spending functions give a value of zero when the proportion of accumulated information is zero.
a(0) = 0 (for alpha-spending)
B(0) = 0 (for beta-spending)

e Spending functions are increasing functions.

e Spending functions give a value of alpha (or beta) when the proportion of accumulated information
is one.

a(1) = a (for alpha-spending)
B(1) = B (for beta-spending)
Using spending functions in group-sequential analyses is very flexible in that neither the information

proportions nor the number of stages need be specified in advance to maintain Type | and Type Il error
protection.
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Spending Functions Available in this Procedure

The following spending functions are shown as alpha-spending functions. The corresponding beta-spending
function is given by replacing a with f5.

O'Brien-Fleming Analog

The O'Brien Fleming Analog (Lan & DeMets, 1983) roughly mimics the O'Brien-Fleming (non-spending
function) design, with the key attribute that only a small proportion of alpha is spent early. Its popularity
comes from it proportioning enough alpha to the final stage that the final stage boundary is not too
different from the fixed-sample (non-group-sequential) boundary.

a(0)=0

Zl—a/Z
(pp) =2 — 2@ (—)
a(pr) \/ﬂ

al)=a«a

Group-Sequential Plot
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Pocock Analog

The Pocock Analog (Lan & DeMets, 1983) roughly mimics the Pocock (non-spending function) design, with
the key attribute that alpha is spent roughly equally across all stages.

a(0)=0
a(px) = aln (1 + (e — D)py)

al)=a«a

Group-Sequential Plat
3.0 4

2.5

2.0 4

15 @® ZValue
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0.5 -

0.0 T T T 1
0.0000 0.0005 0.0010 0.0015 0.0020

Information

Power Family

The power family of spending functions has a p parameter that gives flexibility in the spending function
shape.

a(0)=0
a(pr) =g, p>0
al)=a«a

A power family spending function with a p of 1 is similar to a Pocock design, while a power family spending
function with a p of 3 is more similar to an O'Brien-Fleming design.
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p=1
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p=3
. Group-Sequential Plot
34
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Information

Hwang-Shih-DeCani (Gamma Family)

The Hwang-Shih-DeCani gamma family of spending function has a y parameter that allows for a variety of
spending functions.

a(0)=0
1_e_ypk
= — |, v#0
a(py) a( 1_e7 ) 14
alpy) =apg, vy =0

a)=a«a
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y=-3
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Adjusted Confidence Intervals

Except at the first stage, the raw (naive) estimates of the confidence interval limits are inherently biased in
the group-sequential analysis setting. The method given in Reboussin, DeMets, Kim, & Lan (1992) is used to
calculate appropriately adjusted confidence limits and is based on Kim and DeMets (1987). This stage-wise
ordering method is recommended by Jennison and Turnbull (2000) as “the only method available for use
with unpredictable information sequences.”

The methods used for the calculation of these confidence limits are based on the assumption that the
current stage is the stopping stage of the study (typically from the crossing of a boundary).

As the methods in Reboussin et al. (1992) give only efficacy boundary results, the calculation adjustments
are based only on the efficacy boundaries. The futility boundaries are not used in these calculations, except
as they affect the efficacy boundaries.

Adjusted ‘p-values’

As the raw (naive) p-value is inherently biased in the group-sequential analysis setting, a sequential-test
adjusted p-value should be used instead. Rather than giving a p-value in this procedure, a search is used to
determine the adjusted confidence interval level at which an interval limit equals zero. As such, the methods
used for this calculation are also based on the assumptions that the current stage is the stopping stage of
the study. Again, only efficacy bounds are used.

Adjusted Hazard Rate Difference

The adjusted hazard rate difference is rough estimate of the difference calculated simply as the midpoint of
the adjusted confidence interval limits.

Conditional Power

From Jennison and Turnbull (2000) pages 205 to 208, the general upper one-sided conditional power at stage
k for rejecting a null hypothesis about a parameter 6 at the end of the study, given the observed test
statistic, Z, is computed as

Zi\[Tx — 21 [ Ix + 0 (I — Ik)>
VI — I '

the general lower one-sided conditional power at stage k is computed as
—Zk\/E - Zl—a\/E — 0l — 1k)>

JIk — I ’
and the general two-sided conditional power at stage k is computed as

Zk\/K - Zl—a/zm + 0 — Ik)) P (—Zk\/ﬁ - Zl—a/zm -0k — Ik))
JIk — I, Ik — I, '

Puk(g) = q)<

Py (8) = q><
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where

0 = the parameter being tested by the hypothesis

NCSS.com

k = an interim stage at which the conditional power is computed (k=1, ..., K- 1)

K = the stage at which the study is terminated, and the final test computed

Z, = the test statistic calculated from the observed data that has been collected up to stage k

I, = the information level at stage k
Ix = the information level at the end of the study

Z1_q = the standard normal value for the test with a type | error rate of a.

For a test of one Poisson rate with null hypothesis Hy: h = hy, where h is the population hazard rate, these

components are computed following the logic in Chang (2008) pages 70 and 71 as

6 = h— hy (the expected difference under the alternative hypothesis)

Zi = (R — ho)/T (the z-statistic computed from the observed data)

1

I, = == the interim information level
k 7 (hk) ( )
Iy = Giz (the final information level)

‘K

ng

where
Ay is the sample mean, estimating A; at stage k
I, is the estimated information from the sample at stage k
n, is the sample size at stage k
n is the final sample size

Ay is the mean/variance

Computing conditional power requires you to set A. This value can come from the value used during the
planning of the study, from similar studies, or from an estimate made from the data that has emerged.
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Predictive Power

Predictive power (a Bayesian concept) is the result of averaging the conditional power over the posterior
distribution of effect size. From Jennison and Turnbull (2000) pages 210 to 213, the general upper one-sided
predictive power at stage k is given by

_(ZiIx = 21T
Py =@
JIx — I

The general lower one-sided predictive power at stage k is given by

—zkm—zl_am>

Ix — I

Plk=CD<

The general two-sided predictive power at stage k is given by

P =& <|2k|\/ Iy = Z1-a/2+ 1k> P <_|Zk|\/ Iy = Z1-a/2+ Ik)
e =
VIk — Ik VIk — Ik

with all terms defined as in the equations for conditional power.

Using Simulation to obtain Future Boundary Crossing Probabilities

It can be useful to researchers to know the probability of crossing future group-sequential boundaries, given
the data already obtained, and given the specified assumed value for the hazard rate. The following steps
are used to estimate these probabilities using simulation:

1. From the data obtained to the current stage, obtain a current estimate of the information.

2. Determine the target (cumulative) sample sizes and numbers of events for each future stage,
including the final stage. Fractional sample sizes are rounded up to the next integer.

3. For each simulation, append simulated values to the current sample data to obtain a data set with
the final stage sample sizes. Simulated values correspond to the assumed hazard rate.

4. For each data set, determine which boundary or boundaries were crossed first (except in the case of
non-binding futility boundaries). The proportion of simulations crossing each boundary (first)
provides an estimate of the probability of crossing each boundary, given the specified assumed
hazard rate.

Non-binding Futility Boundaries

When non-binding futility boundaries are used, the study may continue when a futility boundary is crossed.
The simulation proportions will have a slightly different interpretation when this is the case.
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Data Structure

The data for this procedure is entered in three columns, with an additional column to identify the stage
times. Two columns give the individual start and end times. A censor column identifies whether the end
time is due to an event or to censoring.

These four columns are assigned on the Variables tab of the procedure. The current stage is also identified
directly on the Variables tab.

|~ Rotate View l=3 [ - ” |(§)l
1 ' 2 3 4 5 6 7 8 F
Name StartDate  EndDate Censor  Start End StageTimes C7 c8 C
Label
Data Type DateTime DateTime General General General General General General C
Format
Value Labels =
Value Order
Transformation (StartDate (EndDate-
Note
Group By
Filter -
4w »
StartDate EndDate Censor |.f Start 4 End StageTimes C7 cs Cl2
1 172002017 12/4/2018 0 0.054087 1.925823 1
2 2/13/2017 10/28/2019 0 0119607 2821918 2
3 4/1/2017 11/16/2017 0 0246729 0.873973 3
4 4/12/2017 12/18/2018 0 0278786 1.961709
5 5/3/2017  9/13/2019 0 0.336544 269863
6 5/13/2017 0 0364182
7 5/26/2017  9/10/2018 0 0.39894 1.690411
8 6/7/2017  9/11/2017 0 0431824 0.693151
9 6/10/2017 8/20/2018 0 0438385 16332
10 6/30/2017 0 0493433
1" 7/13/2017  3/28/2019 0 0529171 2.235616
12 719/2017  6/23/2018 0 0.545554 1.473973
13 7/19/2017 0 0545886
14 7/25/2017  12/3/2017 1 0564376 0.920548
15 8/17/2017 10/30/2018 0 0.625952 1.827397 =
16 9/22/2017 0 0.725683
17 10/9/2017 12/21/2018 0 0.770431 1.969863
18 11/11/2017  12/28/2017 0 0.861529 0.989041
19 12/9/2017  5/30/2018 0 0937542 1.409536
20 12/21/2017 8/9/2018 0 0972108 1.60274
21 1/10/2018 0 1.026133
22 1/20/2018 8/6/2019 0 1.054206 2.597208
23 1/24/2018 0 1.065512
24 4/9/2018  4/13/2019 0 1.269714 2281068
25 5/26/2018 0 1.399723
2A RIAIPN18 0 1 A24495

For this data set, start dates and end dates are converted to start and end times through a transformation.
The transformation for converting to year times, is

StartDate — TimeODateValue
365

Time =
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For this dataset, the study began on January 1, 2017. The corresponding day value for January 1, 2017 is
42736. This value is found by entering the date in an empty column, changing the Data Type to Date & Time,
and then changing the Data Type back to General. Thus, the formula is

StartDate — 42736
365

Start Time =

and

EndDate — 42736
365

End Time =

The units for the Start, End, and StageTimes columns are years. Any units may be used, but the units must
be consistent throughout the use of the procedure. For example, if years are the units, then hazard rates
must be yearly hazard rates. Conversions may be accomplished through the Survival Parameter Conversion
Tool, which is available through the Tools menu.

If an individual has not had an event at the time of the stage analysis, but is still in the study, the end time
should be left blank, as in

StartDate EndDate Censor .4 Start 4 End StageTimes C7 cs ClI
16 9/22/2017 0 0.725683
17 10/9/2017  12/21/2018 0 0.770431 1.969863
18 11/11/2017 12/28/2017 0 0861529 0.989041
19 12/9/2017 5/30/2018 0 0.937542 1.409536
20 12/21/2017  8/9/2018 0 0972108 1.60274
21 1/10/2018 0 1.026133
22 1/20/12018 8/6/2019 0 1.054206 2.597208
23 1/24/2018 0 1.065512
24 4/9/2018  4/13/2019 0 1.269714 2281068
25 5/26/2018 0 1.399723
26 6/4/2018 0 1.424425
27 6/11/2018 12/6/2018 0 1.442409 1928767
28 6/26/2018 9/26/2019 1) 1.483295 2 736064
29 6/26/2018 11/26/2019 0 1484241 290174
30 7/15/2018  11/1/2018 0 153571 1.835168
31 9/1/2018 0 1.667682
32 9/13/2018 5/16/2019 0 1.700095 2371102
33 9/16/2018 0 1.708062
34 10/18/2018 0 1.794758
35 11/4/2018 0 1.843474
36 12/2/2018 0 1.920484
37 12/8/2018 7/14/2019 0 1.936954 2531507
38 12/9/2018 0 1939469 1
39 1/28/2019 0 2.076068
40 2/21/2019 0 2140154
41 3/9/2019  9/1/2019 0 2185732 2665753 =
42 3/12/2019 0 2.192201
43 3/14/2019 0 2197264
44 4/12/2019  8/4/2019 0 2278883 259041
45 4/20/2019 0 2299153
46 5/26/2019 10/10/2019 0 2398827 2773827
a7 5/28/2019 0 2.403905
43 6/8/2019 0 2433817
49 8/7/2019 12/8/2019 0 2598426 2934247
A0 2/24/2010 11/22/2010 1. 2 RAAR12 2 2a2428
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Example 1 - Group-Sequential Analysis

A colorectal cancer study is conducted to determine whether a new treatment following tumor excision will
resultin a longer time before tumor recurrence (lesser hazard rate). The new treatment is compared to the
historical treatment hazard rate of 0.714. The response for each patient is time, in years, before recurrence.
A one-sided test with alpha equal to 0.025 is used. The MLE-based (difference) Z-Test for comparing a
hazard rate to a null value will be used.

The null and alternative hypotheses are
Ho:h - ho =0 (HO: hNew = 0.714’)

versus

Hyth—hy <0 (Hg: hyew < 0.714)

The design calls for five stages of one year each, if the final stage is reached. The current stage is the 3
stage. In the design phase, a needed power of 0.90 called for 121 patients if the final stage is reached, based
on an assumed hazard rate of 0.5 for the new treatment. Accrual is expected to continue at an even rate.
The loss hazard rate is assumed to be 0.03. Both efficacy and non-binding futility boundaries are
implemented. The efficacy (alpha-spending) spending function used is the O'Brien-Fleming analog. The
Hwang-Shih-DeCani (Gamma) beta-spending function with gamma parameter 1.5 is used for futility. Accrual
is intended to be steady over the 5-year period of the study.

The boundary plot for stage 2 appeared as

Group-Sequential Plot

a
O oo
|
o O @ ZValue
(_8 2 @ Z Crossed Efficacy
w il ] L] © Z: Crossed Futility
N - Efficacy Boundary
O Futility Boundary
-4
-6 T T T )
0 50 100 150 200
Information

resulting in continuance of the study to stage 3.
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Setup

To run this example, complete the following steps:

1 Open the GS Survival1 example dataset

From the File menu of the NCSS Data window, select Open Example Data.
Select GS Survival1 and click OK.

2 Specify the Group-Sequential Analysis for One Hazard Rate procedure options

Find and open the Group-Sequential Analysis for One Hazard Rate procedure using the menus or

the Procedure Navigator.

The settings for this example are listed below and are stored in the Example 1 settings file. To load
these settings to the procedure window, click Open Example Settings File in the Help Center or File

menu.

Variables Tab

Start Time Variable..........cccccooeviiiiiiciieenn, Start

End Time Variable ..............ccooooiiiii End

Censor Indicator Variable .............cccccceeeeeniiie Censor
CenSOred.......ccoevivieiiieiiiecie e 1
NOt Censored..........ueeeveeeiiiiiiiiei e 0

Stage Times Variable .........ccccccovviiiiiiene s StageTimes

Current Stage (K) ..ooooeevoieeiieieeeieiiieiieee e 3

Maximum Number of Stages (K)........cccccceeeee.. 5

Time Proportion at each Stage...........ccc.cceeuee Equally incremented

O 121

e 0.5

DO 0.714

TO (Accrual or Recruitment Time).................... 5

Accrual Parameter Entry........c.ccccoecvvvveneeeniinnns Enter Accrual Parameter Directly

Accrual Parameter...........cceeeeveeeiiiiiiiiene e 0

T (Total TIME) ...eeeeiieeee i 5

L (Loss Hazard Rate)..........cccovveveeeiviinineeneenn, 0.03

Future Stage Time Adjustment........................ Keep original design time proportions exactly

Boundaries Used ...........cccoovcivviierieeiiiiiiieeneen One-sided Efficacy with Futility

Hypothesis DireCtion...........ccccvveeeeeiiiiiiieeneenn. Ha:h-h0<0

Boundary Specification ............cccccoeveiiiiieeneenn. Spending Function Calculation

AlPNa .. 0.025

Alpha Spending Function..............ccoceeeeeninine O'Brien-Fleming Analog

Skipped Efficacy Stages......cccccovviiieeieneeeniinnns <Empty>

Beta ..o, 0.10

Beta Spending Function ...........cccccooeiiiieeneennn. Hwang-Shih-DeCani (y)
KPP PP PP 1.5

Skipped Futility Stages ........ccccceevvviiiiiieeeeeiiinns <Empty>

Binding or Non-Binding Fultility........................ Non-Binding
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Reports Tab

NCSS.com

Reports for Current Stage

All REPOIS .ot Checked
Confidence Level........cccovviiiiiiieiiiieeeiiiieee 95
Number of Simulations .......................... 2000

All Three Boxes under Conditional .................. Checked
and Predictive Power and Boundary

Crossing Probability Parameters
e 0.714
Planning Stage (Stage 0) Reports

Summary using Z Scale.......c.cccoovvciiiiieneeeiiiins Checked
PlOtS o Checked
Plots Tab

Z-Statistic vs Information .............ccccevvvveieiennnnns Checked
Z-Statistic VS TIME ......eeeeiiiieiiiiee e Checked

Note: You can add the stage number to the plot by checking the small box on the Plot Format button (under Z-
Statistic vs Information and Z-Statistic vs Time). When the procedure is run, select the Stage Notes tab and press

the Add Stage Number button.

n the procedure

Click the Run button to perform the calculations and generate the output.

Run Summary Report

This report can be used to confirm that the input was processed as intended.

Run Summary Report

Item Value
Maximum Number of Stages (Design): 5
Current Stage: 3

Alternative Hypothesis:

h - h0 < 0 (one-sided)

Alpha Spending Function: O'Brien-Fleming Analog
Beta Spending Function: Hwang-Shih-DeCani (y = 1.5)
Futility Boundaries: Non-Binding
Alpha: 0.0250
Maximum Information: 168.0322
Z Statistic: MLE
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Z-Values and Boundaries at Stage 3

This section gives the Z-test values and boundaries, numerically. These values are reflected in the group-
sequential boundary plot. The Decision column indicates whether a boundary was crossed at each stage.

Z-Values and Boundaries at Stage 3

Maximum Information:
Alternative Hypothesis:

168.0322

h - h0 < 0 (one-sided)

Futility Boundaries: Non-Binding
Z Statistic: MLE
Boundaries

Z-Test Information
Stage Value Efficacy Futility Time Proportion Decision
1 -2.0753 -5.3241 0.3546 1.0 0.1692 Continue
2 -2.1354 -3.3420 -0.6325 2.0 0.4032 Continue
3 -2.7325 -2.3762 -1.5490 3.0 0.7339 Crossed Efficacy
4 -2.3172 -1.5753 4.0 0.8102
5 -2.0363 -2.0363 5.0 1.0000

Group-Sequential Boundary Plot at Stage 3

This plot shows the Z-test values and boundaries. The efficacy boundary is crossed at Stage 3.

Group-Sequential Boundary Plot at Stage 3

Group-Sequential Plot
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Group-Sequential Plot
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P-Values and Boundaries at Stage 3

This section reflects the conversion of the Z-test values and boundaries to the corresponding P-values and

P-value boundaries.

P-Values and Boundaries at Stage 3

Maximum Information:  168.0322
Alternative Hypothesis: h - h0 < 0 (one-sided)

Futility Boundaries: Non-Binding
Z Statistic: MLE
Boundaries

Z-Test Information
Stage P-Value Efficacy Futility Time Proportion Decision
1 0.01898 0.00000 0.63855 1.0 0.1692 Continue
2 0.01636 0.00042 0.26352 2.0 0.4032 Continue
3 0.00314 0.00874 0.06069 3.0 0.7339 Crossed Efficacy
4 0.01025 0.05759 4.0 0.8102
5 0.02086 0.02086 5.0 1.0000

P-values and P-value boundaries are one-sided values.
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Current Stage Results Adjusted for Sequential Analysis (Stage 3)

This section gives appropriate adjustments to the raw results to reflect the group-sequential nature of the
analysis. Additional explanation is given in early sections of this chapter: Adjusted Confidence Intervals,
Adjusted p-values, and Adjusted Hazard Rate Difference.

Current Stage Results Adjusted for Sequential Analysis (Stage 3)

Group-Sequential Adjusted Difference

Conf. Level

Actual 95.0% C.I. of Diff. Where Upper

Difference C.L Boundary

Stage Sample h - hO Lower Upper Midpoint Is Zero
3 -0.24607 -0.49275 -0.07957 -0.28642 99.327%

The adjustments are based only on the efficacy boundaries. The futility boundaries are not used in these
calculations.

Descriptive Statistics up to Stage 3

This section gives the raw sample statistics for the cumulative data at each stage.

Descriptive Statistics up to Stage 3

Event

Count
Stage N E h hO h - hO SE
1 20 3 0.32482 0.71400 -0.38918 0.18753
2 38 14 0.45457 0.71400 -0.25943 0.12149
3 56 27 0.46793 0.71400 -0.24607 0.09005
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Information Report at Stage 3

This section gives the target and achieved information for each stage, as well as the sample sizes and hazard
rates used to calculate those informations.

Information Report at Stage 3

Maximum Information:
Alternative Hypothesis:

168.0322

h - h0 < 0 (one-sided)

Alpha: 0.0250
Target Achieved
Information Information Target Achieved

Stage Proportion Proportion Information Information N h hO
1 0.0799 0.1692 13.4224 28.4343 20.00 0.32482 0.714
2 0.2601 0.4032 43.7081 67.7521 38.00 0.45457 0.714
3 0.4880 0.7339 82.0075 123.3121 56.00 0.46793 0.714
4 0.7386 *0.8102 124.1150 *136.1419 *56.00 *0.46793 *0.714
5) 1.0000 *1.0000 168.0322 *168.0322 *61.98 *0.46793 *0.714

* Projected value

Because h0 was used for planning and h is used for achieved information, the achieved information occurs
sooner and with fewer needed subjects than the planned targets.

Alpha Spending at Stage 3

This section shows how alpha was spent (or is anticipated to be spent) across the stages.

Alpha Spending at Stage 3

Target Final Stage Alpha:

Spending Function:

0.0250

O'Brien-Fleming Analog

Nominal Percentage Cumulative

Information Alpha Spent Cumulative (Boundary) Alpha Spent Percentage

Stage Proportion this Stage Alpha Spent Alpha this Stage Alpha Spent

1 0.1692 0.0000 0.0000 0.000000 0.0 0.0

2 0.4032 0.0004 0.0004 0.000416 1.7 1.7

3 0.7339 0.0085 0.0089 0.008745 33.9 355

4 * 0.8102 0.0039 0.0128 0.010246 15.5 51.1

5* 1.0000 0.0122 0.0250 0.020859 48.9 100.0
* Projected
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Beta Spending for Futility at Stage 3

This section shows how beta was spent (or is anticipated to be spent) across the stages.

Beta Spending for Futility at Stage 3

Target Cumulative Beta at Final Stage:
Spending Function for Futility:

0.1000
Hwang-Shih-DeCani (y = 1.5)

Nominal Percentage Cumulative

Information Beta Spent Cumulative (Boundary) Beta Spent Percentage

Stage Proportion this Stage Beta Spent Beta this Stage Beta Spent
1 0.1692 0.0289 0.0289 0.638550 28.9 28.9
2 0.4032 0.0296 0.0584 0.263523 29.6 58.4
3 0.7339 0.0275 0.0859 0.060688 27.5 85.9
4* 0.8102 0.0046 0.0905 0.057589 4.6 90.5
5* 1.0000 0.0095 0.1000 0.020859 9.5 100.0

* Projected

Conditional and Predictive Power Report at Stage 3

This section gives the conditional power for the various differences assumed. It also gives the predictive

power.

Conditional and Predictive Power Report at Stage 3

Maximum Information:
Information this Stage:

168.0322
123.3121
Proportion of Maximum Information:  0.7339

Predictive Power: 0.9794
) ) Conditional
Name Value Power
Design -0.2140 0.9850
Data -0.2461 0.9914
o1 0.0000 0.7698

The conditional power values are calculated based on Jennison and Turnbull (2000), pages 205 to 208. They do not account for

future interim stages, nor futility boundaries, if applicable.
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Boundary Probabilities for 6 =-0.214

Using simulation based on the specified hazard rate, this section gives the estimated probabilities of
crossing each of the future boundaries. Values given here will vary for each simulation.

Boundary Probabilities for & =-0.214

Number of Simulations:
User-Entered Random Seed:

Futility Boundaries:

After Efficacy Boundary Crossing:
After Non-Binding Futility Boundary Crossing:
Alternative Hypothesis:

2000
6259540
Non-Binding
Hold Out
Leave In

h - h0 < 0 (one-sided)

Z Statistic: MLE
h: 0.5
ho: 0.714
o: -0.214
Efficacy Futility

Z-Test
Stage N Value Boundary Probability Boundary Probability
1 20.00 -2.0753 -5.3241 0.3546
2 38.00 -2.1354 -3.3420 -0.6325
3 56.00 -2.7325 -2.3762 -1.5490
4 *56.00 -2.3172 0.8665 -1.5753 0.0130
5) *61.98 -2.0363 0.0850 -2.0363 0.0605

* Simulation sample size (Non-integer sample sizes were rounded to the next highest integer.)

Event Summary for 6 =-0.214

Using simulation based on the specified hazard rate, this section gives the estimated number of events at
each future stage. Values given here will vary for each simulation.

Event Summary for 6 = -0.214

Number of Simulations: 2000
User-Entered Random Seed: 6259540
h: 0.5
ho: 0.714
O: -0.214
Average Cumulative

Z-Test Number of Events
Stage N Value E Time
1 20 -2.0753 3 1.00
2 38 -2.1354 14 2.00
3 56 -2.7325 27 3.00
4 *56.00 **37.69 *4.00
5 *61.98 **45.15 *5.00

* Simulation sample size (Non-integer sample sizes were rounded to the next highest integer.)

** Simulation average
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Boundary Probabilities for 6 = -0.246072

Boundary Probabilities for & = -0.246072

Number of Simulations: 2000
User-Entered Random Seed: 6259540
Futility Boundaries: Non-Binding
After Efficacy Boundary Crossing: Hold Out

After Non-Binding Futility Boundary Crossing: Leave In
Alternative Hypothesis:

h - h0 < 0 (one-sided)

Z Statistic: MLE
h: 0.467928
ho: 0.714
O: -0.246072
Efficacy Futility

Z-Test
Stage N Value Boundary Probability Boundary Probability
1 20.00 -2.0753 -5.3241 0.3546
2 38.00 -2.1354 -3.3420 -0.6325
3 56.00 -2.7325 -2.3762 -1.5490
4 *56.00 -2.3172 0.9045 -1.5753 0.0050
5 *61.98 -2.0363 0.0680 -2.0363 0.0405

* Simulation sample size (Non-integer sample sizes were rounded to the next highest integer.)

Event Summary for & =-0.246072

Event Summary for & = -0.246072

Number of Simulations: 2000
User-Entered Random Seed: 6259540
h: 0.467928
ho: 0.714
O: -0.246072
Average Cumulative

Z-Test Number of Events
Stage N Value E Time
1 20 -2.0753 3 1.00
2 38 -2.1354 14 2.00
3 56 -2.7325 27 3.00
4 *56.00 **37.23 *4.00
5 *61.98 **44.45 *5.00

* Simulation sample size (Non-integer sample sizes were rounded to the next highest integer.)
** Simulation average
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Boundary Probabilities for 6 =0

Boundary Probabilities for 8 = 0

Number of Simulations: 2000
User-Entered Random Seed: 6259540
Futility Boundaries: Non-Binding
After Efficacy Boundary Crossing: Hold Out

After Non-Binding Futility Boundary Crossing: Leave In
Alternative Hypothesis:

h - h0 < 0 (one-sided)

Z Statistic: MLE
h: 0.714
hO: 0.714
O: 0
Efficacy Futility

Z-Test
Stage N Value Boundary Probability Boundary Probability
1 20.00 -2.0753 -5.3241 0.3546
2 38.00 -2.1354 -3.3420 -0.6325
3 56.00 -2.7325 -2.3762 -1.5490
4 *56.00 -2.3172 0.4625 -1.5753 0.1530
5 *61.98 -2.0363 0.1265 -2.0363 0.4985

* Simulation sample size (Non-integer sample sizes were rounded to the next highest integer.)

Event Summary for 6 =0

Event Summary for 5 =0

Number of Simulations: 2000
User-Entered Random Seed: 6259540
h: 0.714
ho: 0.714
o: 0
Average Cumulative

Z-Test Number of Events
Stage N Value E Time
1 20 -2.0753 3 1.00
2 38 -2.1354 14 2.00
3 56 -2.7325 27 3.00
4 *56.00 **40.84 *4.00
5 *61.98 **48.99 *5.00

* Simulation sample size (Non-integer sample sizes were rounded to the next highest integer.)
** Simulation average
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Z-Values and Boundaries at Stage 0

This section gives the boundaries that were initially projected at the planning stage.

Z-Values and Boundaries at Stage 0

Maximum Information:  168.0322
Alternative Hypothesis: h - h0 < 0 (one-sided)

Futility Boundaries: Non-Binding
Z Statistic: MLE
Boundaries

Z-Test Information
Stage Value Efficacy Futility Time Proportion Decision
1 1.1312 1.0 0.0799
2 -4.2416 -0.0358 2.0 0.2601
3 -3.0043 -0.8473 3.0 0.4880
4 -2.3791 -1.4724 4.0 0.7386
5 -2.0109 -2.0109 5.0 1.0000

Group-Sequential Boundary Plot at Planning Stage (Stage 0)

This plot shows the projected boundaries at the planning stage.

Group-Sequential Boundary Plot at Planning Stage (Stage 0)

Group-Sequential Plot
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Group-Sequential Plot
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Kaplan-Meier Survival Plot

In order to obtain a Kaplan-Meier survival curve plot, the data must be converted into a form that can be

used in the Kaplan-Meier Curves (Logrank Tests) procedure:
1. Rows with blank end times should be identified as censored.

2. Blank end times must be filled in with the current stage time.

3. An Elapsed Time column should be created by subtracting start times from end times.

When these steps are taken, the GS Survival1 dataset becomes the GS Survival1 B dataset.

Setup

To run this example, complete the following steps:

1 Open the GS Survival1 B example dataset
o From the File menu of the NCSS Data window, select Open Example Data.
« Select GS Survival1 B and click OK.

2 Specify the Kaplan-Meier Curves (Logrank Tests) procedure options

« Find and open the Kaplan-Meier Curves (Logrank Tests) procedure using the menus or the

Procedure Navigator.
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The settings for this example are listed below and are stored in the Example GS1 settings file. To load
these settings to the procedure window, click Open Example Settings File in the Help Center or File

menu.
Variables Tab
(Elapsed) Time Variable ...........cccccceeeiiiiiiinenn. Elapsed
Censor Variable ..o Censor
Failed.......ccooi 0
(1= o T0] (=T o RPNt 1
Reports Tab
Data SUMMArY.......coocciiiieiieeicciieee e Checked
All Other REPOIS ....cccceiiiiiiiiieiee e Unchecked
Plots Tab
Individual-Group PIOtS ........ccovvieeiieiiiiiieeeeee Unchecked
Combined PIOt(S) ...ccceeiviiviiiiiieeiieiiiiiiee e Checked

Kaplan-Meier Survival/Reliability Plot Format (Click the Button)

Kaplan-Meier Survival Line...........cccccccoevvnneen.. Checked
Confidence LIMitS..........covvveeeeeieiiieiiiieeeeeeeeeeen, Checked
Confidence Limits - Fill .........covvvvvvvvvveveieieiennnns Checked

3 Run the procedure

Click the Run button to perform the calculations and generate the output.

Kaplan-Meier Survival Curve(s)

This plot shows the survival curve.

Kaplan-Meier Survival Curve(s)

Survival

Survival Plot
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80% -
60% -
40%
20%
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Example 2 - Skipping Stage Boundaries

Suppose that the setup is the same as in Example 1, except that the first two futility boundaries are skipped.

Setup

To run this example, complete the following steps:

1 Open the GS Survivall example dataset

» From the File menu of the NCSS Data window, select Open Example Data.
» Select GS Survival1 and click OK.

2 Specify the Group-Sequential Analysis for One Hazard Rate procedure options

« Find and open the Group-Sequential Analysis for One Hazard Rate procedure using the menus or

the Procedure Navigator.

» The settings for this example are listed below and are stored in the Example 2 settings file. To load
these settings to the procedure window, click Open Example Settings File in the Help Center or File

menu.

Variables Tab

Skipped Futility Stages ........cccccceeues

3 Run the procedure

+ Click the Run button to perform the calculations and generate the output.

Run Summary Report

The skipped futility stages are now reported.

Run Summary Report

Iltem Value
Maximum Number of Stages (Design): 5
Skipped Futility Stage(s): 12
Current Stage: 3

Alternative Hypothesis:
Alpha Spending Function:
Beta Spending Function:

h - h0 < 0 (one-sided)
O'Brien-Fleming Analog
Hwang-Shih-DeCani (y = 1.5)

Futility Boundaries: Non-Binding
Alpha: 0.0250
Maximum Information: 168.0322
Z Statistic: MLE
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Z-Values and Boundaries at Stage 3

The futility boundaries change slightly from those where no boundaries are skipped.

Z-Values and Boundaries at Stage 3

Maximum Information:  168.0322
Alternative Hypothesis: h - h0 < 0 (one-sided)
Futility Boundaries: Non-Binding
Z Statistic: MLE
Boundaries

Z-Test Information
Stage Value Efficacy Futility Time Proportion Decision
1 -2.0753 -5.3241 1.0 0.1692 Continue
2 -2.1354 -3.3420 2.0 0.4032 Continue
3 -2.7325 -2.3762 -1.7451 3.0 0.7339 Crossed Efficacy
4 -2.3172 -1.6482 4.0 0.8102
5 -2.0363 -2.0363 5.0 1.0000

Group-Sequential Boundary Plot at Stage 3

The plot now has two futility boundaries skipped.

Group-Sequential Boundary Plot at Stage 3
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Group-Sequential Plot
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Example 3 - Two-Sided Boundaries

Suppose that the setup is the same as in Example 1, except that the boundaries are now two-sided.

Setup

To run this example, complete the following steps:

1 Open the GS Survivall example dataset
» From the File menu of the NCSS Data window, select Open Example Data.
» Select GS Survival1 and click OK.

2 Specify the Group-Sequential Analysis for One Hazard Rate procedure options

« Find and open the Group-Sequential Analysis for One Hazard Rate procedure using the menus or
the Procedure Navigator.

» The settings for this example are listed below and are stored in the Example 3 settings file. To load
these settings to the procedure window, click Open Example Settings File in the Help Center or File

menu.

Variables Tab

Boundaries Used ..........cccceeeiiiiiiiieineee e, Two-sided Efficacy with Futility (Symmetric)
AlPN@ e 0.05

Overlapped Futility Boundaries........................ Remove (skip) overlapped futility boundaries

3 Run the procedure
+ Click the Run button to perform the calculations and generate the output.

Run Summary Report

Run Summary Report

Item Value

Maximum Number of Stages (Design): 5

Current Stage: 3

Alternative Hypothesis: h - hO # 0 (two-sided, symmetric)
Alpha Spending Function: O'Brien-Fleming Analog

Beta Spending Function: Hwang-Shih-DeCani (y = 1.5)
Futility Boundaries: Non-Binding

Alpha: 0.0500

Maximum Information: 168.0322

Z Statistic: MLE
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Z-Values and Boundaries at Stage 3

Z-Values and Boundaries at Stage 3

Maximum Information: ~ 168.0322
Alternative Hypothesis: h - h0 # 0 (two-sided, symmetric)

Futility Boundaries: Non-Binding
Z Statistic: MLE
Boundaries
Upper Side Lower Side

Z-Test Information
Stage  Value Efficacy 1 Futility 1 Efficacy 2 Futility 2 Time  Proportion Decision
1 -2.0753 5.3241 -5.3241 1.0 0.1692 Continue
2 -2.1354 3.3420 0.7991 -3.3420 -0.7991 2.0 0.4032 Crossed Fut 1
3 -2.7325 2.3762 1.5648 -2.3762 -1.5648 3.0 0.7339 Crossed F1 & E2
4 2.3172 1.5833 -2.3172 -1.5833 4.0 0.8102
5) 2.0363 2.0363 -2.0363 -2.0363 5.0 1.0000

Group-Sequential Boundary Plot at Stage 3

Because they were overlapping, the first futility boundaries are skipped.

Group-Sequential Boundary Plot at Stage 3

Group-Sequential Plot
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Group-Sequential Plot
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Example 4 - Sample Size Re-estimation and Boundary
Probabilities

Suppose that the setup is the same as in Example 1, except that only the data up through Stage 2 has been
collected.

Setup

To run this example, complete the following steps:

1 Open the GS Survival1 2 Stages example dataset
» From the File menu of the NCSS Data window, select Open Example Data.
» Select GS Survivall 2 Stages and click OK.

2 Specify the Group-Sequential Analysis for One Hazard Rate procedure options
« Find and open the Group-Sequential Analysis for One Hazard Rate procedure using the menus or
the Procedure Navigator.
« The settings for this example are listed below and are stored in the Example 4 settings file. To load
these settings to the procedure window, click Open Example Settings File in the Help Center or File
menu.

Variables Tab

Current Stage (K) ..ooooeevoieeiieieeeieiiieiieee e 2

3 Run the procedure
« Click the Run button to perform the calculations and generate the output.

Run Summary Report

This report can be used to confirm that the input was processed as intended.

Run Summary Report

Item Value

Maximum Number of Stages (Design): 5

Current Stage:

Alternative Hypothesis: h - h0 < 0 (one-sided)

Alpha Spending Function: O'Brien-Fleming Analog

Beta Spending Function: Hwang-Shih-DeCani (y = 1.5)
Futility Boundaries: Non-Binding

Alpha: 0.0250

Maximum Information: 168.0322

Z Statistic: MLE
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Z-Values and Boundaries at Stage 2

Examining the Z-Test values, the boundaries, and the decisions, no boundary has been crossed at this stage.

Z-Values and Boundaries at Stage 2

Maximum Information:  168.0322
Alternative Hypothesis: h - h0 < 0 (one-sided)
Futility Boundaries: Non-Binding
Z Statistic: MLE
Boundaries

Z-Test Information
Stage Value Efficacy Futility Time Proportion Decision
1 -2.0753 -5.3241 0.3720 1.0 0.1692 Continue
2 -2.1354 -3.3420 -0.6057 2.0 0.4032 Continue
3 -3.0439 -0.7269 3.0 0.4855
4 -2.4256 -1.3974 4.0 0.7160
5 -2.0054 -2.0054 5.0 1.0000

Group-Sequential Boundary Plot at Stage 2

This plot shows the Z-test values in the vicinity of the efficacy boundary side.

Group-Sequential Boundary Plot at Stage 2

Group-Sequential Plot
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Group-Sequential Plot

NCSS.com
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Descriptive Statistics up to Stage 2
Descriptive Statistics up to Stage 2
Event
Count
Stage N E h hO h - h0 SE
1 20 3 0.32482 0.71400 -0.38918 0.18753
2 38 14 0.45457 0.71400 -0.25943 0.12149
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Information Report at Stage 2 (Gives Sample Size Re-estimation)

This section shows that the target sample size for the next stage can be maintained at 38.

Information Report at Stage 2

Maximum Information:
Alternative Hypothesis:

168.0322

h - h0 < 0 (one-sided)

Alpha: 0.0250
Target Achieved
Information Information Target Achieved

Stage Proportion Proportion Information Information N h hO
1 0.0799 0.1692 13.4224 28.4343 20.00 0.32482 0.714
2 0.2601 0.4032 43.7081 67.7521 38.00 0.45457 0.714
3 0.4880 *0.4855 82.0075 *81.5761 *38.00 *0.45457 *0.714
4 0.7386 *0.7160 124.1150 *120.3093 *47.46 *0.45457 *0.714
5 1.0000 *1.0000 168.0322 *168.0322 *59.33 *0.45457 *0.714

* Projected value

Alpha Spending at Stage 2

This section shows how alpha was spent (or is anticipated to be spent) across the stages.

Alpha Spending at Stage 2

Target Final Stage Alpha:

Spending Function:

0.0250

O'Brien-Fleming Analog

Nominal Percentage Cumulative

Information Alpha Spent Cumulative (Boundary) Alpha Spent Percentage

Stage Proportion this Stage Alpha Spent Alpha this Stage Alpha Spent

1 0.1692 0.0000 0.0000 0.000000 0.0 0.0

2 0.4032 0.0004 0.0004 0.000416 1.7 1.7

3* 0.4855 0.0009 0.0013 0.001168 3.5 5.2

4 * 0.7160 0.0068 0.0081 0.007641 27.1 32.3

5* 1.0000 0.0169 0.0250 0.022458 67.7 100.0
* Projected
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Beta Spending for Futility at Stage 2

This section shows how beta was spent (or is anticipated to be spent) across the stages.

Beta Spending for Futility at Stage 2

Target Cumulative Beta at Final Stage:
Spending Function for Futility:

0.1000
Hwang-Shih-DeCani (y = 1.5)

Nominal Percentage Cumulative

Information Beta Spent Cumulative (Boundary) Beta Spent Percentage

Stage Proportion this Stage Beta Spent Beta this Stage Beta Spent

1 0.1692 0.0289 0.0289 0.645040 28.9 28.9

2 0.4032 0.0296 0.0584 0.272358 29.6 58.4

3* 0.4855 0.0082 0.0666 0.233654 8.2 66.6

4* 0.7160 0.0182 0.0847 0.081152 18.2 84.7

5* 1.0000 0.0153 0.1000 0.022458 15.3 100.0
* Projected

Conditional and Predictive Power Report at Stage 2

Conditional power and predictive power are described earlier in the Technical details section. The predictive
power does not depend on an assumed difference, as does the conditional power.

Conditional and Predictive Power Report at Stage 2

Maximum Information:
Information this Stage:
Proportion of Maximum Information:  0.4032

168.0322
67.7521

Predictive Power: 0.8756
) ) Conditional
Name Value Power
Design -0.2140 0.9133
Data -0.2594 0.9653
o1 0.0000 0.2171

The conditional power values are calculated based on Jennison and Turnbull (2000), pages 205 to 208. They do not account for

future interim stages, nor futility boundaries, if applicable.
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Boundary Probabilities for 6 =-0.214

Given the data that have already accumulated in the first two stages, and assuming a hazard rate of 0.5
going forward, this report gives the simulation probabilities of crossing each of the future boundaries. The
sum of the efficacy boundary probabilities is another estimate of the conditional power.

Boundary Probabilities for & = -0.214

Number of Simulations:
User-Entered Random Seed:

Futility Boundaries:

After Efficacy Boundary Crossing:
After Non-Binding Futility Boundary Crossing:
Alternative Hypothesis:

2000
5696962

Non-Binding

Hold Out
Leave In

h - h0 < 0 (one-sided)

Z Statistic: MLE
h: 0.5
ho: 0.714
o: -0.214
Efficacy Futility

Z-Test
Stage N Value Boundary Probability Boundary Probability
1 20.00 -2.0753 -5.3241 0.3720
2 38.00 -2.1354 -3.3420 -0.6057
3 *38.00 -3.0439 0.2745 -0.7269 0.0100
4 *47.46 -2.4256 0.3760 -1.3974 0.0620
5) *59.33 -2.0054 0.2065 -2.0054 0.1575

* Simulation sample size (Non-integer sample sizes were rounded to the next highest integer.)

Event Summary for 6 =-0.214

Using simulation based on the specified hazard rate, this section gives the estimated number of events at
each future stage. Values given here will vary for each simulation.

Event Summary for & =-0.214

Number of Simulations: 2000
User-Entered Random Seed: 5696962
h: 0.5
ho: 0.714
o: -0.214
Average Cumulative

Z-Test Number of Events
Stage N Value E Time
1 20 -2.0753 3 1.00
2 38 -2.1354 14 2.00
3 *38.00 **24.53 *3.00
4 *47.46 **33.55 *4.00
5 *59.33 **41.69 *5.00

* Simulation sample size (Non-integer sample sizes were rounded to the next highest integer.)

** Simulation average
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Boundary Probabilities for & =-0.259428

Given the data that have already accumulated in the first two stages, and assuming a hazard rate of
0.454572 going forward, this report gives the simulation probabilities of crossing each of the future
boundaries.

Boundary Probabilities for & = -0.259428

Number of Simulations: 2000
User-Entered Random Seed: 5696962
Futility Boundaries: Non-Binding
After Efficacy Boundary Crossing: Hold Out
After Non-Binding Futility Boundary Crossing:  Leave In
Alternative Hypothesis: h - h0 < 0 (one-sided)
Z Statistic: MLE
h: 0.454572
ho: 0.714
o: -0.259428
Efficacy Futility

Z-Test
Stage N Value Boundary Probability Boundary Probability
1 20.00 -2.0753 -5.3241 0.3720
2 38.00 -2.1354 -3.3420 -0.6057
3 *38.00 -3.0439 0.3770 -0.7269 0.0035
4 *47.46 -2.4256 0.4145 -1.3974 0.0330
5) *59.33 -2.0054 0.1370 -2.0054 0.0775

* Simulation sample size (Non-integer sample sizes were rounded to the next highest integer.)

Event Summary for & =-0.259428

Event Summary for & = -0.259428

Number of Simulations: 2000
User-Entered Random Seed: 5696962
h: 0.454572
hO: 0.714
o: -0.259428
Average Cumulative

Z-Test Number of Events
Stage N Value E Time
1 20 -2.0753 3 1.00
2 38 -2.1354 14 2.00
3 *38.00 **23.77 *3.00
4 *47.46 **32.32 *4.00
5 *59.33 **40.28 *5.00

* Simulation sample size (Non-integer sample sizes were rounded to the next highest integer.)
** Simulation average
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Group-Sequential Analysis for One Hazard Rate

Boundary Probabilities for 6 =0

Given the data that have already accumulated in the first two stages, and assuming a hazard rate of 0.714
(the same as the null value) going forward, this report gives the simulation probabilities of crossing each of
the future boundaries.

Boundary Probabilities for & = 0

Number of Simulations:
User-Entered Random Seed:

Futility Boundaries:

After Efficacy Boundary Crossing:
After Non-Binding Futility Boundary Crossing:
Alternative Hypothesis:

2000
5696962

Non-Binding

Hold Out
Leave In

h - h0 < 0 (one-sided)

Z Statistic: MLE
h: 0.714
ho: 0.714
o: 0
Efficacy Futility

Z-Test
Stage N Value Boundary Probability Boundary Probability
1 20.00 -2.0753 -5.3241 0.3720
2 38.00 -2.1354 -3.3420 -0.6057
3 *38.00 -3.0439 0.0345 -0.7269 0.1495
4 *47.46 -2.4256 0.0825 -1.3974 0.5460
5) *59.33 -2.0054 0.0900 -2.0054 0.8245

* Simulation sample size (Non-integer sample sizes were rounded to the next highest integer.)

Event Summary for 6 =0

Event Summary for5 =0

Number of Simulations: 2000
User-Entered Random Seed: 5696962
h: 0.714
hO: 0.714
o: 0
Average Cumulative

Z-Test Number of Events
Stage N Value E Time
1 20 -2.0753 3 1.00
2 38 -2.1354 14 2.00
3 *38.00 **27.68 *3.00
4 *47.46 **37.82 *4.00
5 *59.33 **46.46 *5.00

* Simulation sample size (Non-integer sample sizes were rounded to the next highest integer.)

** Simulation average
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